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Locating EMS Courses on

TR:N

Provider’s Quick Guide

Introduction:

TRAINVirginia is an easy Learning Management System (LMS) to use.

The ability to locate courses which pertain to Virginia EMS providers has been
made easy due to the naming convention we have decided to use. Itis through
this naming convention that the EMS provider will be able to locate continuing
education (CE) courses to register for.

Learning Objectives:

Learn how to:

v log onto the TRAINVirginia website

v locate the “Course Search” section

v' complete a search for EMS courses which are available for
training and CE credit.

Browser Operating Systems
Requirements Supported

WINDOWS WINDOWS

= Internet Explorer 5.5 + = Windows Vista

= Netscape 7.1 + = W indows XP

= W indows 2000

MACINTOSH MACINTOSH

= Mozilla FireFox 1.3 + = OS X 10.2 or greater




Step 1 Locating EMS training courses available on TRAINVirginia

1. Open your web browser and type the following URL into the address bar:
a. https://va.train.org
2. Press ENTER to load the TRAINVirginia home page.
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Become A Course Provider = Qu and participating TRAIN affiliate sites,
* To add your courses lo = Track your learning with personal online iranscripts.
the TRAIN system, = Access valuable materials, course reviews, and discussions to improve your learning experience, and
= Stayinformed of the latest public health trainings for your area or expertise.

Become a provider

Large Font Version

Ifthis is your first visit, click "Create Account” on the left menu to register for TRAIN and start learning today!

If you already have an account, please enter your Login Name and Password in the text-boxes provided on the left menu and click "Login™.

e
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3. Enter your “Login Name” and “Password” and press ENTER to login.
4. Once you successfully log into TRAIN, click on the “Course Search” tab located under the
TRAINVirginia logo.

Virginia Department of Health

TRAINVirginia

Home Course Search Discussion Boards Resources Help q

| Announcements

» Public Health Foundation WELCOME

Website

P Virginia Department of WELCOME ABOARD TR A IN VIRGINIA!

Health Website

» E-Mail the TRAIN Virginia The TRAIN-VA learning management system has left the station. The destination is to img
Administrator national public health educational sources.

» FEMA Emergency ;
Management Institute (EMI) TRAIN-VA allows you to:
Independent Study Courses
P Virginia Department of

Emergency Management
(VDEM) Courses = Register online for courses

= Search for on-site or distance learning courses

= Keep a record of the courses you have taken

Large Font Version
And the best part is that you only have to register ONCE! Let the journey begin....
New Passengers

If you are new to TRAIN-VA, take a look around. Near the top of the page, check out th
your right is "My Learning Record” and "Up Coming Events”. On your left are links to specid

Revised: 12-28-2007 Page 2 of 6



5. Under “Course Search” click on the “Search” icon in the shape of a magnifying glass.

Virginia Department of Health

TRAINVirginia

Home Course Search | Discussion Boards Resources

Search Options Course Search

» Browse Virginia'
» Browse All

Search Search our database of courses by selecting a search option.
» By Course ID
» By Subject %
» By Audience
» By Competency Browse
» By Format
» By Credit Type

Browse through the entire database of Public Health Education and T

» By Course Provider Infd |  Saveunlimited search profiles for future inquiries and receive email n
» ByDate -

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» Advanced Search

6. Under Keyword, type VAOEMS in the text line.
a. All courses approved for Virginia EMS providers can be located under the search
term VAOEMS.

Virginia Department of Health

TRAINVirginia

Home Course Search | Discussion Boards |
Search Options Course Search
P Browse Virginia’ Tip: To make multiple selections under a search option, hold down the CTRL key te select more than one option from)
» Browse All Subject
» By Course ID [Access to Care (includes health insurance) P

; | Agriculture [
Fa BYjSublect |Animal Health
» By Audience | AssessmentAnalysis
» By Competency | Chronic Diseases
| Computer Skills/Training

» ByFormat | Cultural Competence v
» By Credit Type
» By Course Provider O ciinical O Non-Clinical & Both
» ByDate O Local @ Al

» By Distance

» By Accreditation [JFree courses only

P By Certificate And Keyword
> Keyword Search Tip: Use "OR” or "AND" to better define your selected keyword search criteria
» By Training plan p: To search for an exact phrase (e.g., "vaccine administration”), use quotation marks.
» Advanced Search *
Course Title V‘AO E rv‘ S
» Saved Search Criteria O Description
® Both

)
Search Save Criteria
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7. Once you have completed filling in the text line, click on the Search button.

Virginia Department of Heaith

TRAINVirginia

Home Course Search Discussion Boards Core Competencies |
Search Options Course Search
» Browse Virginia' Tip: To make multiple selections under a search option, hold down the CTRL key to select more than one option from the |
» Browse All Subject
» By Course ID [Access to Care (includes health insurance) |
- Agriculture

P By Stbjact Animal Health
» By Audience Assessment/Analysis
» By Competency Chronic Diseases

Computer Skills/Training
» By Format Cultural Competence w|
» By Credit Type
» By Course Provider O cilinical O Non-Clinical ) Both
» ByDate O Local ® AN
» By Distance 0
» By Accreditation Free courses only
» By Certificate And Keyword
» Keyword Search Tip: Use "OR" or "AND" to better define your selected keyword search criteria
» By Training plan Tip: To search for an exact phrase (e.g., “vaccine administration”), use quotation marks.
» Advanced Search e

O Course Title
» Saved Search Criteria O Description

®Both
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8. You will now see a list of available courses offered by the Office of EMS. Click on a
course you would like to take.

Virginia Department of Health

TRAINVirginia

Home Course Search Discussion Boards

Search Options Course Search
» Browse Virginia' Tip: To sort by any column, click the column heading. Or use default order by Keyword Search Proximity
» Browse All Tip: Toview course description, click on the Course Title
Tip: Alphabetical page indexing is used when sorted by Title, Provider or Format
» By Course ID $ =Fee associated with the course % = Creditis offered
» By Subject ) ) e
» By Audience To save the criteria for this search please click here: | Save Crite
» By Competency ] show expired courses
» By Format 20 rows per page :] Page 112
» By Credit Type = . -
» By Course Provider
» ByDate Z (D+DE=  o% VAOEMS: EMSAT Oct 2005 "EMS Regulations: Can | Carry My Own Jump Kit?* h Office of
» By Distance Z Qo-0E= o¥ VAOEMS: EMSAT Nov. 2005 "Bariatrics: "Care of the Morbidly Obese Patient” Office of
» By Accreditation
Z [JD+DE=  o¥% VAOEMS: EMSAT Dec 2005 "BLS Practical Stations Office of
» By Certificate a L < o= e
» Keyword Search Z [JD+sDE=  o% VAOEMS: EMSAT Jan. 2006 “The National Incident Management System” Office of
P By Training plan Z (DD E= % VAOEMS: EMSAT March. 2006 "EMS and Forensics Office of
» Advanced Search Z QoD E= o% VAOEMS: EMSAT Feb. 2006 “Prehospital Care of the Stroke Patient Office of
7 ﬂ == oW VAOEMS: EMSAT April. 2006 "Dealing With Unique Challenges Such as Autism Office of
» Saved Search Criteria =
Z D+DE= % VAOEMS: EMSAT May. 2006 “The Latest n' Greatestin Vehicle Extrication” Office of
Z [ID'DE= % VAOEMS: EMSAT June. 2006 “On Scene Challenge 13 (Trauma Calls) Office of
Z (IDsDE=  o¥ VAOEMS: EMSAT Jan. 2007 "Pandemic Flu Office of
Z -0 E=  o% VAOEMS: EMSAT July. 2006 “Infection Control 2006 Update Office of
Z AnNF= a¢ vanEmc CMSAT Aun 2008 "The Moar Dircwninn Dationt™ Office of

Revised: 12-28-2007 Page 4 of 6



9. Look over any of the information available below about the course. When you are ready
to take the course, click on the Registration tab located below the course title.

Virginia Department of Health

TRAINVirginia

Course Search Discussion Boards

Course Details

VAOEMS: EMSAT Oct. 2005 "EMS Regulations: Can | Carry My Own Jump Kit?" Back
Course Details || Contads | | ngi:str_a'ﬁqu_'t ';"'— Reviews

Course ID: 1005480

Format: Web-based Training - Self-study (Online)

Clinical / Non-Clinical: Non Clinical

Course Number:

Cost (USS$): 0.00

Credit Type(s): 1 of CEUICE

Course Description: Can I carry my ALS gear bag in my family car? Can I carry oxygen in my personal

vehicle? Does the ambulance driver need to be an EMT? Will being a convicted felon
keep me from being in EMS? In this EMSAT, Office of EMS Regulation and Compliance
Manager Michael Berg answers these and many more questions from the field.

CEU: BLS Cat. 1 Area 07 - 1 hour, ALS Cat. 2 - 1 hour

Remember, it is your responsibility as a Virginia EMS provider to assure that
your Virginia certification number is entered correctly in order to receive CE
credit. If you are not sure of your certification number or any other personal
information has been entered correctly, then follow the directions for
“Updating an Existing Account.”

This program will ONLY ACCEPT your certification number, NOT your social
security number.

10. Where it says “Select Credit Type” select CEU/CE in the drop down menu.
a. This is VERY important. YOU MUST make this selection in order for your CE
credit to be properly recorded by the Office.

Virginia Department of Health

TRAINVirginia

Home Course Search Discussion Boards Resources Help Cor{

Course Details

VAOEMS: EMSAT Oct. 2005 "EMS Regulations: Can | Carry My Own Jump Kit?'

Course Details || Contacts || Registration || Reviews

Select Credit Type: | ~Select— | v |

on the ‘Launch’ button.
Note that this cours/None I& to "My Learning’ after you click the button.

To register other people for this course please click on the 'Batch Registration' button. You will be
able to register several people at a time and create new user accounts if they don't exist.

Batch Regis

[Back | [ Find other courses likethis |

© PHF 2003-2007 -
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11. Once you have finished selecting the credit type click on the Launch button.

Virginia Department of Health

TRAINVirginia

Course Search Discussion Boards

Course Details

VAOEMS: EMSAT Oct. 2005 "EMS Regulations: Can | Carry My Own Jump Kit?' Back

Course Details || Contacts || Registration || Reviews

Select Credit Type: | CEUICE |v|

To launch this course,please click on the "Launch’ button. -
Note that this course will be added to ‘My Learning’ after you click the button. @%

To register other people for this course please click on the 'Batch Registration’ button. You will be Batch Registration
able to register several people at a time and create new user accounts if they don’t exist.

[Back| | Find other courses like this |

® PHF 2003-2007 - Confide

12. The course has now been launched. You may continue on to complete the course.

Quit

"EMS Regulations:
Can I Carry My Own Jump Kit?"

Course Description

Can [ carry my ALS gear bag in my family car? Can 1 carry oxygen in my
personal vehicle? Does the ambulance driver need to be an EMT? Will being a
convicted felon keep me from being in EMS? In this EMSAT, Office of EMS Regulation
and Compliance Manager Michael Berg answers these and many more guestions from
Course Description the field.

Introduction

This EMSAT Video in approximately 58:00 Minutes in length

Course Objectives

EMSAT is produced by the Division of Educational Development,
Office Of Emergency Medical Services, Virginia Department of Health, Annual EMSAT
EMSAT Video & subscriptions and individual videos are available by calling 1-800-523-6019 or 1-804-
Evaluation 864-7600. A list of EMSAT programs and designated viewing sites may be found on

the Office of EMS external web site at www.vdh virginia.gov/oems
; , l 8 t -

Powered by ' L * " .‘;
7 Virginia #8
Go to the next page for course objectives ‘D ‘)
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13. Follow the directions for the course and complete the quiz at the end of the program.
14. DO NOT close your browser UNTIL you get your quiz results online.
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